
NUAnswers Startup Guide 

 

Welcome to NUAnswers.  Our goal is to help you provide second to none materials to your 

clients and prospects. 

This document will walk you through using NUAnswers from initial setup to creating a presentation for 

your clients or prospects. 

Product Overview 
First, what are the ways in which you can use NUAnswers?  NUAnswers combines client 

educational concepts from Advisys and National Underwriter.  NUAnswers helps you at every stage of 

the client development life cycle. 

 

NUAnswers includes client education and presentation materials on all of the important 

financial planning topics, investments, life insurance, annuities and other products.  They meet FINRA 

guidelines and are written in everyday language average Americans can understand. 

  



 

For example, they can be used to create an approach piece, or as seminar handouts.  They can  

be used for first appointments, or leave behinds when prospecting for new business.  They can be used 

to help service existing clients.  Or for a quarterly or annual review of your clients goals. Best of all, any 

of these reports can be combined into a single presentation just by clicking on the check box next to the 

title.  It’s just that easy to create a completely personalized client presentation. 

We’ll discuss these features in more detail later. 

  



Setting Your Preferences 
The first step is to setup NUAnswers preferences.  This involves add your company information, adding 

or editing the disclosure and disclaimer provided by NUAnswers, and adding your Personal Profile page.  

The entire process to set up your preferences takes 10-15 minutes. 

To prepare to set up your preferences you’ll need: 

 Your title and designations 

 Your company name and address, contact information and website address 

 Your company logo (available either on your computer hard drive or accessible on your 

computer network) 

 A photo of you (if you wish to include a Personal Profile page with your picture) 

Company Information 

The company information is used to populate the Title Page with your information. 

 

This is how to enter this information 

 

Open the Company Information screen by selecting Tools and then Company Information.   
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This is where you enter the information about you; what designations you hold, title, company 

name and address and contact information.  If you have a website, enter that here also.  Add your logo 

by selecting Browse and then navigate to your website.  Select Save.  All of this information will now 

appear on the Title Page, which will be further discussed as part of building a presentation. 

Disclaimer and Disclosure 

The next step in getting the tool matched to your needs is to review and edit the disclaimer and 

disclosure, if necessary. 

 

NUAnswers provides a basic disclaimer.  The purpose for the disclaimer is to let the client know 

that these reports are not guarantees of future performance and should not be relied on solely when 

making financial decisions.  Modify this to meet your compliance needs, then select Save. 

 

NUAnswers also provides a basic disclosure.  The purpose for the disclosure is to let the client 

know the companies that you might be representing and the appropriate disclosure information 

regarding those companies.  Modify this to meet your compliance needs, then select Save. 



Personal Profile 

 

The Personal Profile page is intended for you to let your clients and prospects know about you 

and your firm.  This is intended to be a brief biography about you and a brief history about your firm and 

the services offered.  It is not mandatory that you include a Personal Profile page.  If you don’t wish to 

include a Personal Profile page, or if you want to create it later, you can skip this step. 

 

Start by creating the content for this report.  Be sure to include relevant information about you 

and your background and some basic information about your firm.  Next enter a title for the report.  Add 

a picture of you or your firm by selecting Browse and navigate to the desired image.  Finally, select a 

layout.  The layout determines the location of a picture if any; either in the center, left or right, or not at 

all.  Click on Save and the Profile report is ready to include in a presentation. 

  



Presentation Defaults 

 

The next step is to select the presentation defaults.  A presentation is a collection of reports, 

about one or multiple topics, that you wish to bundle into one complete package to present to your 

clients or prospects.  By selecting the defaults to be contained in a presentation, you don’t have to do it 

each time you create a new presentation.  The questions you have to answer are: 

 

Do you want to include the following in most of your presentations: 

 Title page 

 Table of contents 

 Personal Profile Page 

 Disclaimer and/or a disclaimer 

 Record of reports? 

 Do you want a header on each page, such as the client’s name? 

Do you want a footer on each page, such as your phone number or company name? 

Some people put the clients name as the footer.  There is no correct answer, only your preference.   

Do you wish to include page numbers?  If so, do you wish to include just page numbers on each 

page, or include the total number of pages in the presentation on each page too?  In many cases, 

compliance prefers that presentations also include the total number of pages on each page.  This is so it 

is easy to see when a page is missing.  

Select save and you have completed all defaults for building a presentation. 

Basic Navigation 



This section will explain the some of the basic navigation and features of NUAnswers and conclude with 

building a presentation 

 

This is the Home Screen, it is what you will see each time you log into the product. 

Along the left are quick navigation icons.  Across the top is the menu bar.  These will both be covered a 

little later in the document. 

The links below the menu bar are ways to find the reports that you want to view, print or add to a 

presentation.   

Starting on the Health/Medical you can see all of the reports that are contained in the NUAnswers 

product that deal with Health and Medical related topics.  To Open the folder, simply click on the title of 

the folder that you wish to open.  You will then see a list of reports displayed featuring either the 

Advisys Logo, or the National Underwriter Logo.  This is to easily identify which content is which. 

 

  



The next topic, Investments/Taxes contains reports related to investments, as well as taxes.   This would 

allow you to easily educate your client on the different types of investments they may want or need to 

include in their overall portfolio. 

 

The third topic, Income Sources, contains material that covers a variety of different income sources that 

a client or prospect may need to know for Retirement purposes. 

 

The final tab is Protecting Finances, this is where you can find reports on Life Insurance as well as 

Business Succession planning. 

 

Clicking on the arrow next to the topic, opens the folder.   Also, clicking on the title of the folder will 

open it as well.  

Click on the arrow in a sub folder shows the available reports.   

To see the report, click on the report title. The report displays on the right side of the screen.  Anytime 

that you click on a report title, the report will display on the right side of the screen.  



 

You can print this report by clicking on the Print icon on the left  

 

You can also save this report as a pdf file by clicking on the Save pdf icon. 

 

 You can open the pdf file at a later time for printing or to email it to a client or prospect.  When the 

report is saved or printed, NUAnswers will use the layout options that you entered in the Presentation 

default screen under Tools 



.  

To combine several reports into one presentation, check the box next to the report that you want 

included.  

  



Finish the Presentation 

 

You can see the report that we have selected for the client.  Since I elected to include the Personal 

Profile Page in the Presentation Defaults under the Tools menu, that report is also included. 

 

You can see the presentation options have all been selected based on the defaults that were setup 

earlier.  You can change the selections for this client on this screen and still retain your defaults for all 

future clients. 

One suggestion is to add the client names on the header. 

Now enter the client name and address.  They will appear on the title page. 

 

 

The last step is to add a title and select the format of the title Page.  



 

The title for this will be Preparing for Retirement 

Select the page template, the only difference is the location of the picture; top, middle, bottom or none 

The last step is to add a picture that is relevant to your client.  To do this, you will want to have stock 

photos available to you that you can access on your hard drive or on your computer network.  Or you 

can take a photo of something using your cell phone or digital camera and save it to your computer hard 

drive or network to add to your presentation. 

 

Select the picture to add and select Open 

  



The presentation is now complete 

 

It is recommended that you preview the presentation before printing or saving as a pdf file. 

 

To save the client you are working on, click the save client icon. 

 

You will be prompted for a Client Name, Description and any notes that you may want to save with the 

client file. 

 

Click on Save 

Now you are ready to print or save the presentation as a pdf file.  Just click on the Print or Save PDF 

icons 

  



Left Navigation Bar 

When you sign into the NUAnswers product this is what you will see.  This portion of the document will 

focus on the left navigation bar. 

The first icon is Clear Selections  

 

Click on this when you want to erase all data and report selections and start fresh.  When you click on 

this, it appears that nothing happens because all that happens is the data that you have entered is 

erased from memory, but not erased from the saved files. 

The next icon is the View Clients.   

 

When you click on this, you will see a list of all of your saved client files.  You can sort the files by clicking 

on the column headings.  To find the most recent client that you saved, click on the arrow in the 

Changed column and select descending. 

 

  The files are now sorted from most recent to oldest.  You can do this on each column.   



 

Clicking on the Pencil allows you to enter notes about the client.  Just remember to save the notes  

 

To see the description and notes, click on the plus sign.  Click again to close the section  

 

Now that you have the list of client files, check the box next to the file that you wish to open.  This will 

enable your ability to select open.  

When you have completed entering client information or creating a presentation, select the Save client 

icon 

 

  

If this is the first time that you have worked with this client file, you will be prompted for a name and 

description.  If you are working with a client file that you have previously saved, this icon will overwrite 

the saved file with the one that you have open.  This is the same behavior that you will experience with 

word processing or spreadsheet products.  

 

 If you don’t want to replace or over write the data in the original client file, go to the File menu at the 

top of the screen and select “Save Client As”to create a new file. 

  



The Save PDF icon 

 

The Save Pdf icon will save the report displayed on the right hand side as a pdf so that it can either be 

printed later, or emailed to a client as an attachment. 

And the Print icon 

 

Will print or save whatever is in the right side of the application using the rules that you have defined in 

the Presentation Options screen under the Tools menu. 

The last icon is help.   

 

The help topics appear on the right side of the application   

 

Help is always available  

  



 

Click here to make the right side fill the screen.  This also works when you are viewing reports.  Clicking 

again returns the right side to the normal view.  

 

Click on the Search tab to enter key words 

 

There are help topics on Adding a report to a presentation, creating a presentation, as well as 

presentation contents 

  



Across the top of the application is the menu bar 

 

Starting with the File menu 

You can see Clear, this is the same as selecting clear selections on the left navigation bar 

Next is View Clients, this is same as the View Clients icon on the left navigation bar 

The next item is Save Client.  This is the same functionality as the Save Client icon on the left navigation 

bar. 

Save Client As allows you to save the current client information with a name other than the one that is 

currently saved.  This is useful if you want to save multiple versions of files for the same client such as 

annual updates.  You might want to save the file as Paul and Sally Johnson – 2015 and the following year 

save the file as Paul and Sally Johnson 2016. 

The Save Client to File, allows you to save the current client information to a file on your local computer.  

This is useful if you want to share your client information with an associate. 

Import Template is a feature that will be discussed in the Using Templates video. 

  



The tools menu 

 

Contains two options not yet covered 

The first is options 

 

The first is to show report numbers.  Each report in the NUAnswers product is identified with a unique 

report id number.  If you would like to see these numbers displayed along with the report name, check 

this box. 

The other option is to print with FINRA letters.  This feature is designed to help streamline the 

compliance review process.  Many of the reports in the product have been filed with FINRA.  If your 

compliance officer would like to see the letters received from FINRA when reviewing your presentations, 

select this option.  When you print a presentation, or single report, or save them to PDF, the FINRA 

review letter will be added to the back of the presentation.  This is for compliance use only and will not 

appear in the table of contents nor will they be paginated with the rest of the presentation.  You can 

then mail or email the presentation and FINRA letters to compliance for review. 

  



The last menu option, with the exception of logout, is help. 

 

The first item, NUAnswers Help is the same as selecting the Help icon on the left navigation bar. 

The next item is to show the home page.  This is the same as selecting the Home icon above the report 

display window 

License/Privacy Agreement displays the license agreement that you agreed to when you first signed into 

NUAnswers.  The privacy statement let’s you know that you do not share your information with anyone. 

Email Support opens a window that let’s your send an email to the support desk. 

The last item, About NUAnswers, shows the version of the product that you are using.  This is helpful to 

the support desk if you call with a question. 

The last item is logout.  Select this when you are finished using NUAnswers for the day. 




